15th LFD Workshop in Advanced Fluorescence Imaging and Dynamics

Computer Training

Irvine, CA
October 25–29, 2021

Laboratory for Fluorescence Dynamics (LFD)
Department of Biomedical Engineering
University of California, Irvine
Fluorescence Correlation Spectroscopy (FCS)

This part contains 4 exercises to be completed in about 2-3h

Exercise 1. Simulation of Single Point FCS

Exercise 2. Simulation of monomer-dimer. Resolving the system using autocorrelation and PCH analysis

Exercise 3. Simulation of two-color experiments: cross-correlation analysis of heterodimer formation

Exercise 4. Simulation of fluorescence kinetics: FRET fluctuations

Exercise 1. Simulation of Single Point FCS

A_ Setting up the problem

1. Open SimFCS (Fig. 1)

![SimFCS 2.0](image)

2. Select “Simulate FCS data” in the action panel at the left-hand side of the screen (Fig 2).
A “simform” panel opens up (Fig. 3).

3 Select “Parameters” from the menu at the top of the screen (Fig. 3).

A menu will pop up with 9 tabs and different options for the simulation (Fig 4):
PSF: This tab has the options for the shape of the point spread functions (Fig. 5)

4. Select “3-D Gaussian” from the pull-down menu.

5. Set the Radial Waist ($r$ or $y$) to 0.3 (the units are microns) and the Axial Waist to 1.5 μm.

   Ignore the value of Radial Waist ($x$)—this refers only to point spread functions that are not cylindrically symmetric.
The \textit{a\_astig} and \textit{m\_astig} parameters are for introducing astigmatism to the PSF and should be set to zero.

The \textit{plotting threshold} is simply for visualization and will not affect the outcome of the simulation.

6. Set the box size to 64.

This is actually the half size of the box. Since the simulation moves the particles in a random walk along a grid of points spaced 0.05 \( \mu m \) apart, this will give a box with 6.4 \( \mu m \) along each dimension.

7. Set the multiple points field to 1.

Ignore the \textit{slit separation} as this is for more complex simulations, as well as \textit{x,y,z for non-scanning} and leave \textit{Perfect 0\_9N.psf}

\textit{Note that if you click the last line of this tab gives you the volume of the box and the size of the PSF in \( \mu m^3 \)}

\textbf{Particles}: This tab allows you to choose the numbers and types of particles for the simulation (Fig 6).

We will be doing a single species simulation, so only the first row will have particles.

8. In column “\# mol” column choose 100 molecules.

\textit{Note: The maximal number of particles is 4000.}

9. In column “Br1 (cpsm)” choose a brightness of 100,000 counts per second per molecule (cpsm).

\textit{This is the average intensity at the peak of the point spread function.}
10. In column “D (µm²/s)” set the diffusion coefficient to 40 µm²/s.

Note that at the bottom left hand corner of the tab, there is a Max D value in µm²/s. This maximum value is set by the simulation based on the time per channel (clock frequency) which we will set later. This D value is the value at which the probability of making two grid steps in one-time step becomes significant. It is possible to set the diffusion coefficient to a value higher than this, but the simulation will be physically unrealistic, because grid steps greater than one are not allowed.

Ignore the rotation value for now.

11. Set “Br2” to zero.

This is the brightness of the particle in the second channel. It is set to zero because we will only be simulating one detection channel.

The “Flow” column introduces a directional movement and will not be used in this exercise.

12. Select type “1” for normal particles in the seventh column “1..6”.

At the bottom right of the table is a legend showing the type of particle that this last column can designate. A “2” in this column indicates that the particle will rotate with a time constant equal to the value in the rotation column, which is in units of time channels. A “3” and “4” in this column refer to different shapes of macromolecular assemblies, like molecules on a stick (DNA) and molecules on a disk (rafts).

Misc: This tab contains options for rotation, flow, background, and particle confinement (Fig. 7).
13. Select “randomize data” and

14. “Use Poisson dist for counts.”

These settings are appropriate for simulating photon counting, not analog detection. For analog detection, on top of a Poisson distribution there is an additional exponential distribution due to the process of electron multiplication in the photomultiplier.

Time/scan: This tab allows for the simulation of circular scanning, line scanning, camera scanning or raster scanning FCS (Fig. 8).
15. Make sure the “Scanning” check box is unchecked.

16. Set the clock frequency to 100,000 counts/sec/particle. Note that in this simulation we are using 10 µs dwell time.

   *The frequency is the inverse of the dwell time in seconds*

17. Set the “Cycles” field to 50.

   *One cycle is the amount of time required to collect 2^{15} data points.*

   *At the right-hand side of the tab, the actual simulation time (time(s)=) is shown in seconds.*

   The “Binning Mode,” “Use sections,” and “Number of bins for linear scale” fields are for display during the simulation and will not affect the outcome.

The following tabs will be ignored for now:

**Stick/Disk:** This tab allows the simulator to change the shape and properties of the stick or disk particles selected under the Particles tab.

**Reaction:** This tab allows for reactions (exchange of properties) between particles (rows) defined in the Particles section. This allows to simulate bleaching, FRET or other chemical reactions.

**Display:** The tab allows for the change of the display during the simulation run. It does not affect the simulation.
TZone 2D: The tab allows for parameters related to transient confinement of particles.

Binding 2D: Used to introduce sites of binding in the simulation

Channel 2D: Used to simulate diffusion/transport across a channel

3D object: Used for the simulation of 3D shapes.

B_Running the Simulation:

18 Click on “Parameter” (Fig. 9)

19 Click on “Start_simulation” at the top of the simform window.

20 Select “Isotropic diffusion” from the pull-down menu.

After a moment, the simulation will start.

If you like, select “Show PSF” (this will show a 3D threshold plot of the PSF). This can also be done before the simulation to demonstrate the different PSFs. In addition, the particles can be plotted in real time (“Plot particles” checkbox). All of these display options slow the simulation considerably, so it is advisable to turn them off for the majority of the simulation.

Most plots in SimFCS can be modified by double clicking on the graph. The plotting routine is TeeChart Pro and a free editor for Tee Chart Pro, Tee Chart Office, can be freely downloaded at:

Also, during the simulation, the data will register on the main SimFCS screen (Fig. 9) similar to the way real data acquisition would register. The top plot, an accordion plot, displays the intensity per second in red, and the \(G(0)\) value of channel 1, estimated by the variance divided by the intensity squared, in green. On the bottom plot, the logarithmically binned autocorrelation function is plotted. This function is calculated as the average of each cycle (2^15 points) and is calculated using the multiple tau approach. Note that this should only be used for visual purposes during the simulation. After the simulation is complete, the “Recalculate” button (on the lower right of the screen) can be pushed to get a more robust estimation of the autocorrelation function.

C_Analyzing the Data:

21_Click “Analysis” under the main SimFCS screen, on the top menu (Fig. 10).

22_Select “Large vector correlation” from the pull-down menu.

A new window (corrform) opens (Fig. 11).
This section of the program calculates the autocorrelation function based on the fast Fourier transform (FFT). Since the FFT requires data to have a size that is a power of two, the autocorrelation function is calculated in appropriately sized sections. In this example:

23. Select the entry 256K (not 256!).

24. Select “Plot each segment” (screen bottom left), before starting the calculation to view these segments as they are calculated.

25. Press the “calculate” button to begin the calculations.

The individual autocorrelation segments can be deleted. This capability is extremely useful in deleting, for example, a section of the data that contains a spike, often due to a diffusing aggregate.

To delete an anomalous autocorrelation segment:

-Click on it when it will appear red.

-Press “Delete segment”, then

-Press “Recalculate average” to recalculate the autocorrelation average without the (offending) segment

Note that the errors are also calculated and can be visualized by selecting “Plot errors.” When the data are saved (“Save correlation files”), the errors are saved as well. They can then be used as weighting factors for fitting.

At the end of the calculation, the average is shown on the top graph (may be difficult to see if you are plotting each segment). The bottom graph shows the logarithmically binned data. This format is generally...
accepted for FCS data. On the right-hand side of the page is the photon count histogram (PCH) and its average.

26. Select the “fit” tab on top of the corrform window (Fig. 12).

The “corrfit” window will pop up (Fig. 13).
27. Input the values for the waist=0.3 (in micron)


29. Initialize the fit by extrapolating the value of $G(0)$ from the graph.

   *This step is not necessary, but it is important that the initial value of $G(0)$ is different from zero.*

30. Select “use weights”

31. Set “Fix Bkgd” unchecked.

   *This will allow the background to vary.*

32. Click on “perform fit”.

To fit the PCH data:

33. Click on the upper left corner on the down arrow menu and switch from “autocorrelation 1” to “PCH 1”.

   *NOTE: It is important that the initial values of N1 and epsilon 1 are close to 1. If you start with values that are very large, the fitting routine will not find the minimum.*

34. Click on “perform fit”.
Equations:

\[ V_{PSF} = \int PSF \, dr^3 \]

\[ \gamma = \frac{\int PSF^2(r) \, dr^3}{\int PSF(r) \, dr^3} \]

3D Gaussian:

\[ PSF(r, z) = \exp\left(\frac{-2r^2}{\omega_r^2} + \frac{-2z^2}{\omega_z^2}\right) \]

\[ V_{3DG} = \omega_r^2 \cdot \omega_z \cdot \left(\frac{\pi}{2}\right)^{3/2} = 1.9687 \cdot \omega_r^2 \cdot \omega_z \]

\[ \gamma_{3DG} = 2^{3/8} = 0.3536 \]

Gaussian-Lorentzian Squared:
\[ PSF(r, z) = \frac{4 \omega_r^4}{\pi^2 \omega_z^4} \exp\left(-\frac{4 r^2}{\omega_z^2}\right), \text{ where } \omega_z^2 = \omega_r^2 \left(1 + \frac{z \lambda}{\pi \omega_r^2}\right) \] 

\[ V_{GE} = \frac{\omega_r^4 \pi}{\lambda} \]

\[ \gamma_{GL} = \frac{3}{(4 \pi^2)} = 0.076 \]

Avogadro number 1M = 6.023 \times 10^{23} molecules/liter

1 \mu m^3 = 1 fL = 10^{-15} L

Questions:

1. Calculate the number of particles from the autocorrelation fit (G(0) = \gamma/N). How does this compare to the PCH results? The value for \gamma is given in the lines above

2. The PCH analysis didn’t allow for variation of beam shape parameters like \omega_o or \omega_z. Why not?

3. Calculate the concentration of particles in the simulation box. Hint: 1 \mu m^3 = 1 \times 10^{-15} Liters. In the simform, when you select the shape and size of the PSF, in the bottom line you have the volume of the PSF and the volume of the box. If you change the beam waist or other parameters, click on the line that shows the volume in the PSF tab to refresh. Now calculate the concentration of particles from the simulations. How do these compare?

4. For a typical confocal experiment, the radial waist is 200 nm and the axial waist is 600 nm. For a typical two photon experiment at 800 nm, the radial waist is 300 nm. Which one of the two volumes is smaller? Calculate the expected G(0) for these two experiments given an equal concentration of particles in the box. If you like, verify the results with a simulation. Comment on the signal to noise of single photon vs. two photon measurements.

5. Attempt to fit the autocorrelation function obtained in the simulation to different \omega_z/\omega_r ratios. Comment on the sensitivity of FCS to the z dimension of the PSF. Why do you think this is?
6. Attempt to fit the autocorrelation function obtained in the simulation to different beam (radial) waists. Does the goodness of fit change? Explain.

7. Imagine a spherical point spread function with amplitude 1 inside radius, $r$, and amplitude zero outside this radius. Calculate the gamma factor for this PSF. Comment on the effect of the point spread function shape on the gamma factor. (Hint: think about the value of the fluctuation for particles occupying different parts of the profile of illumination. Consider a completely flat profile and ask yourself what will be the fluctuation in this limiting case. Then consider how the abruptness of the profile of illumination will change the fluctuations and try to predict which profile will give the maximum fluctuations).

8. Attempt to fit the PCH and the autocorrelation curves from the above simulation to the Gaussian Lorentzian squared model (2-photon formulas). Comment on the sensitivity of the two techniques (autocorrelation function and PCH analysis) to the shape of the point spread function.

9. Using the equation for the volume of the 3D Gaussian, calculate the $\omega_r$ and $\omega_z$ values for a spherically symmetric PSF ($\omega_r = \omega_z$) with a volume equal to that for the previous simulation. Run a simulation with these parameters and compare the PCH and the autocorrelation to what we observed previously. Do you expect any change?

Exercise 2. Simulation of monomer-dimer. Resolving the system using autocorrelation and PCH analysis

Setting up the problem:

For the formation of a dimer, the brightness and volume might both be expected to double. The diffusion coefficient is inversely proportional to the cube root of the particle volume (the particle radius), so it will be multiplied by a factor of $(0.5^{1/3} = 0.794)$, or approximately $32 \mu m^2/s$, if $40 \mu m^2/s$ is the diffusion coefficient of the monomer.
Set up the simulation as we did in exercise 1 (steps 1 to 7), except for the particles section.

1. Open SimFCS (Fig. 1)

2. Select “Simulate FCS data” in the action panel at the left had side of the screen (Fig 2).

3. Select “Parameters” from the menu at the top of the screen (Fig. 3).

4. Select “3-D Gaussian” from the pull down menu (Fig. 5).

5. Set the Radial Waist (r or y) to 0.3 (the units are microns) and the Axial Waist to 1.5 µm (Fig. 5).

6. Set the box size to 64 (Fig. 5).

7. Set the multiple points field to 1 (Fig. 5).

In the particles section (Fig. 15):

35. Set the number of particles at 75 (mol#) with a brightness of 100,000 cpsm (Br1 cpsm) for monomers.

36. For dimmers set 25 particles at 200,000 cpsm.

37. Set the diffusion for monomers at 40 and for dimmers at 32 (D (µm²/s))
Running the Simulation:

Run the simulation following Steps 18 to 20 of exercise 1 (Fig. 9).

18. Click on “Parameter”.

19. Click on “Start_simulation” at the top of the simform window.

20. Select “Isotropic diffusion” from the pull-down menu.

Analyzing the Data with GLOBALS FOR IMAGES (SimFCS):

Repeat steps 21-32 of exercise 1 (Figs. 10 to 13)

21. Click “Analysis” under the main SimFCS screen, on the top menu (Fig. 10).

22. Select “Large vector correlation” from the pull-down menu (Fig. 10).
23. Select 256K (not 256!’) (Fig. 11).

24. Select “Plot each segment” (screen bottom left), before starting the calculation to view these segments as they are calculated (Fig. 11).

25. Press the “calculate” button to begin the calculations (Fig. 11).

26. Select the “fit” tab on top of the corrform window (Fig. 12).

27. Input the values for the waist=0.3 (Fig. 13)

28. Deselect 2-photon formulas. (Fig. 13)

29. Initialize the fit by extrapolating the value of G(0) from the graph (Fig. 13).

30. Select “use weights” (Fig. 13).

31. Set “Fix Bkgd” unchecked (Fig. 13).

32. Click on “perform fit” (Fig. 13).

To fit the PCH data:

38. Select on the upper left corner on the down arrow menu and switch from “autocorrelation 1” to “PCH 1”.

39. Initialize the values for N and epsilon and leave N1, epsilon 1 and N2, epsilon 2 unchecked to allow the two species to vary.
Equations:
\[ G(0) = \sum_{m=1}^{M} \left( \frac{\langle I_m \rangle}{\langle I \rangle} \right)^2 G(0)_m, \] where \( I_m \) is the intensity of species \( m \).

\[ \langle I_m \rangle = \varepsilon_m \cdot N_m, \] where \( \varepsilon_m \) and \( N_m \) are the brightness and number of species, \( m \).

\[ \langle I \rangle = \sum_m \varepsilon_m \cdot N_m. \]

Questions:

1. Calculate \( G(0) \) from the above equations for the simulation performed earlier. How does this compare with the simulation results?

2. One can imagine an experiment where the brightness of each species is known as well as the total number of particles (concentration). It is now possible to calculate the concentration of each species. Perform this analysis for the above simulation (note that the total number of molecules in the simulation is 125, not 100).

3. In the analysis of the simulation PCH, we used the constraint that the dimer was twice as bright as the monomer (on the upper left corner on the down arrow menu and switch from “PCH 1” to “PCH 1 monomer/x-mer”). This is not always the case (e.g. self quenching, etc...). Try to do the analysis without this constraint. Now do the global analysis without the constraint.

4. How much different do you think the molecular volumes would have to be in order to resolve the two species in an autocorrelation analysis? If desired, test your hypothesis with a simulation.

Exercise 3. Simulation of two-color experiments: cross-correlation analysis of heterodimer formation
Setting up the problem:

40_Set up the simulation with three types of particles as seen in Fig 17 (arrows).

Fig. 17

Here we have entries under Br2 which refers to the brightness in channel 2.

The first two particles are our monomeric species, one with brightness in channel 1 and the other in channel 2. They happen to both have the same diffusion coefficient, so the simulation is essentially the same as for Exercise 2.
The third species is the heterodimer, consequently, have brightness in both channels.

Running the Simulation:

Run the simulation following Steps 18 to 20 of exercise 1 (Fig. 9).

18. Click on “Parameter”.
19. Click on “Start_simulation” at the top of the simform window.
20. Select “Isotropic diffusion” from the pull-down menu

Analyzing the Data with GLOBALS FOR IMAGES (SimFCS):

We are going to analyze the data in three different ways:

- Autocorrelation in channel 1.
- Autocorrelation in channel 2.
- Cross-correlation between channel 1 and 2.

**Autocorrelation in Channel 1.**

Repeat steps 21-44 of exercise 1 (Figs. 10 to 14)

21. Click “Analysis” under the main SimFCS screen, on the top menu (Fig. 10).
22. Select “Large vector correlation” from the pull-down menu (Fig. 10).
23. Select 256K (not 256!) (Fig. 11).
24. Select “Plot each segment” (screen bottom left), before starting the calculation to view these segments as they are calculated (Fig. 11).
Under the large vector correlation screen, you will notice that at the upper left of the dialog, there is a set of radio buttons grouped under “function”. In the previous exercise we had “Ch1 autocorrelation” checked (Fig.18).

![Fig. 18]

25. Press the “**calculate**” button to begin the calculations (Fig. 11).

26. Select the “**fit**” tab on top of the corrform window (Fig.12).

27. Input the values for the **waist=0.3** (Fig. 13)

28. Deselect 2-photon formulas. (Fig.13)

29. Initialize the fit by extrapolating the value of **G(0) from the graph** (Fig. 13).

30. Select “**use weights**” (Fig.13).

31. Set “**Fix Bkgd**” unchecked (Fig.13).
32. Click on “perform fit” (Fig.13).

To fit the PCH data:

33. Click on the upper left corner on the down arrow menu and switch from “autocorrelation 1” to “PCH 1” (Fig.14).

34. Click on “perform fit” (Fig.14).

Results are shown in Fig. 19.

**Fig. 19**

**Autocorrelation in Channel 2.**

Select “Ch2 autocorrelation” and do that analysis the same way as Ch1.

**Note:** Do not forget to properly initialize the fit by extrapolating the value of $G(0)$ from the graph.
The autocorrelation for channel 2 should appear in blue in the bottom graph (Fig. 20). The information in the upper graph is overwritten when a new analysis is done, so make sure that you delete any outliers and recalculate the average before analyzing a new channel.

**Cross-correlation between channel 1 and 2**

Now select “Ch1-Ch2 cross-corr” and perform the analysis.

**Note:** Do not forget to properly initialize the fit by extrapolating the value of $G(0)$ from the graph.
The cross-correlation will appear in green along with the two autocorrelations (Fig. 21).

You can also do the “Ch2-Ch1 cross-corr” if you like, but the result will be the same and the Ch1-Ch2 data will be overwritten. Also, only one cross correlation can be saved at a time.

The cross-correlation is only sensitive to species that diffuse together in both channels, so you can fit the data to a Gaussian single species model as in Exercise 1.

Equations:

\[
G_{cc}(\tau) = \frac{\left< \delta I_{ch1}(t) \cdot \delta I_{ch2}(t+\tau) \right>}{\left< I_{ch1}(t) \right> \left< I_{ch2}(t) \right>} = \frac{\left< I_{ch1}(t) \cdot I_{ch2}(t+\tau) \right>}{\left< I_{ch1}(t) \right> \left< I_{ch2}(t) \right>} \approx \frac{\left< I_{ch2}(t) \cdot I_{ch1}(t+\tau) \right>}{\left< I_{ch1}(t) \right> \left< I_{ch2}(t) \right>} - 1,
\]
where $ch1$ and $ch2$ refer to channel 1 and channel 2 respectively. \( G_{ee}(0) = \gamma \sum_{m=1}^{M} \frac{\epsilon_{m,ch1} \cdot \epsilon_{m,ch2} \cdot N_m}{\langle I_{ch1} \rangle \langle I_{ch2} \rangle}, \)

where $N_m$ is the number of type $m$ particles in the focal volume and $\epsilon_{m,ch1}$ and $\epsilon_{m,ch2}$ are the brightnesses of species $m$ in each channel.

\[
\langle I_{ch1} \rangle = \sum_m \epsilon_{m,ch1} \cdot N_m.
\]

Questions:

1. Using the above equations, calculate the concentration and brightness of each of the three species in our system.

2. In most two-color experiments, the microscope filters do not 100% isolate the signals of the different species from one another. This is referred to as crosstalk or bleed-through. Assuming that you know the percentage of bleed-through for each species, is it possible to calculate the concentration of all of the species? Verify this with a simulation if you like.

3. Verify that the above equation for $G(0)$ of the cross correlation is identical to the $G(0)$ for the autocorrelation (see previous exercise) if the $ch1$ and $ch2$ refer to the same channel.

4. Mueller has developed a technique referred to as 2D PCH to look at PCH for 2 color experiments. Globals does not yet have the capability to analyze these results. What to do for this?
Exercise 4. Simulation of fluorescence kinetics: FRET fluctuations

Setting up the problem:

In this exercise, we will simulate a FRET experiment where a system is fluctuating between two states: one with high FRET efficiency (acceptor is highly fluorescent, donor is quenched) and the other with low FRET efficiency.

Create a simulation with two types of particles (100 particles of each type), one with 100,000 cpsm in channel 1 and the other with 100,000 cpsm in channel 2 (Fig. 22).

Under the “Reaction” tab, type 100,000 for both the forward and backward rate (Fig. 23).

(Note that if you don’t want equal concentrations in the two channels, you will have to adjust the ratio of these rates to match the equilibrium constant). Due to the way the simulation is written, this is not the actual rate for the reaction. The actual rate (in reciprocal seconds) is given by:

\[
\text{(input rate*clock frequency)}/3\times10^6
\]

Running the Simulation:

Run simulation as in exercise 1 (Fig. 9)

18. Click on “Parameter”

19. Click on “Start_simulation” at the top of the simform window.

20. Select “Isotropic diffusion” from the pull-down menu.

Analyzing the data with GLOBALS FOR IMAGES (SimFCS)
In the case of cross correlation kinetics data, we have the following form for the autocorrelation:

\[ G(\tau) = K(\tau) \cdot G_{\text{Diffusion}}(\tau) \]

Where \( G_{\text{Diffusion}} \) is the familiar autocorrelation due to the diffusion and \( K \) describes the kinetics:

\[
K(\tau) = 1 + A \cdot \exp\left(-\frac{\tau}{\tau_{\text{kinetics}}}\right) = 1 + s \cdot K \left( f_A - \frac{f_B}{K} \right)^2 \exp\left(-\frac{\tau}{\tau_{\text{kinetics}}}\right)
\]

Where \( s \) is the sign of the exponential (negative for anti-correlation and positive for correlation), \( f_A \) (\( f_B \)) is the fractional intensity of species A (B), \( K=k_f/k_b \) is the ratio of forward and backward rate and \( 1/\tau_{\text{kinetics}} = k_r+k_b \) is the apparent kinetic rate. This equation form is essentially the same as that for triplet kinetics aside from the sign term for the cross correlation.

In order to properly fit the data, we need to link variables between the autocorrelation and cross-correlation fit. First fit the calculated Ch1 autocorrelation curve letting the ‘T1 amplitude’. (positive in this case) and ‘T1 rate’ parameters to vary. These parameters describe the extra-variance due to the reaction kinetics.

Repeat steps 21-31 of exercise 1 (Figs. 10 to 13)

21. Click “Analysis” under the main SimFCS screen, on the top menu (Fig. 10).

22. Select “Large vector correlation” from the pull-down menu (Fig. 10).

23. Select 256K (not 256!) (Fig. 11).

24. Select “Plot each segment” (screen bottom left), before starting the calculation to view these segments as they are calculated (Fig. 11).

25. Press the “calculate” button to begin the calculations (Fig. 11).

26. Select the “fit” tab on top of the corrform window (Fig.12).

27. Input the values for the waist=0.3 (Fig. 13)

28. Deselect 2-photon formulas. (Fig.13)

29. Initialize the fit by extrapolating the value of \( G(0) \) from the graph (Fig. 13).
30. Select “use weights” (Fig.13).

31. Set “Fix Bkgd” unchecked (Fig.13).

42. Uncheck “T1 amplitude” and “T1 rate” (Fig 24).

43. Click on “perform fit” (Fig.24).

Repeat the calculation with cross-correlation (Fig. 25):
44. Select “Ch1-Ch2 cross-corr”

45. Press the “calculate” button

46. Select on the upper left corner on the down arrow menu and switch from “autocorrelation 1” to “Cross-Correlation” (Fig. 26).

47. Check “D1 fix” with the value obtained for the autocorrelation (Fig. 24)

48. Click on “perform fit.”
Questions:
1.) Most FRET experiments are affected by crosstalk (i.e. fluorescence from one species overlapping with the filter band for the other species). In addition, FRET quenching is usually not complete (the donor is not totally quenched in the high FRET state). What effect do you think that will have on the auto- and cross-correlations? Is it possible to calculate the FRET efficiency from the kinetic fraction? You can run simulations to demonstrate these principles.

Run a simulation where significant photobleaching is a problem (i.e. species 2 is non fluorescent and starts with a low number of particles). The rate should be less than one reciprocal second for photobleaching under normal excitation conditions. How does the photobleaching affect the autocorrelation? How about the PCH
Line scanning, ICS and RICS

This part contains 5 exercises to be completed in about 2-3h
Exercise B1. RICS and line scanning simulations
Exercise B2: Simulation using circular scanning
Exercise B3. Line scan analysis of adhesions
Exercise B4. RICS analysis of cell images
Exercise B5. Simulation of N&B data

Exercise B1. RICS and line scanning simulations

Setting up the simulation

Set the parameter for “PSF” and “Misc” as in exercise A1: note that for this exercise we are using w0=0.25 for the waist of the 3D Gaussian.

1. Open SimFCS (Fig. A1).
2. Select “Simulate FCS data” in the action panel at the left hand side of the screen (Fig A2).
3. Select “Parameters” from the menu at the top of the Simform window. (Fig. 3).

In the PSF tab (Fig. A5):
4. Select “3-D Gaussian” from the pull-down menu.
5. Set the Radial Waist (r or y) to 0.25 (the units are microns) and the Axial Waist to 1.5 µm
6. Set the box size to 64.
7. Set the multiple points field to 1.
In the **Misc** tab (Fig. A7):

13. Select “**randomize data**” and
14. “Use Poisson dist for counts.”

In the **Particle** tab (Fig. B1):

49. Set **100 particles** of brightness **100,000** and **D** of **10 µm²/s**.

50. Set **Rotation** to **10**.

51. Type to **1**

In the **Time/scan** tab (Fig B2):
52. Make sure the "Scanning" check box is checked.

53. Check Raster scan.

54. Select grid size of 128 (128 x 128 points).

55. Set the clock frequency to 64,000 (pixel dwell time 1/64000).

56. Set the "Cycles" field to 50.

Leave other parameters as shown in Fig B2.
Select "Start simulation" and then "Isotropic Diffusion" as in exercise A1 (Fig. A9):

18. Click on "Parameter"

19. Click on "Start_simulation" at the top of the simform window.

20. Select "Isotropic diffusion" from the pull-down menu.

After few minutes, the simulation will finish.

C. Analyzing the Data:

57. Click "Analysis" under the main SimFCS screen, on the top menu (Fig. B3).

58. Select "RICS" from the pull-down menu.
A new window (ICS) opens (Fig. B4).
59. Change the “Size” of the image and both of the “ROI analysis” and “ROI reading” fields to 128.

60. Set “Frames to process for ACF” field to 100.

The different frames of the simulation can be scrolled. If you have scrolled through the images, return to frame 1 before continuing.

61. Go the “Tools” menu (Fig. B4).

62. Select “RICS” (Fig. B5).

63. Select “Subtract average” (Fig. B5)
The spatial correlation operation is performed from the 100 frames of the stack and the correlation for each image is averaged to produce the screen below (Fig. B6).
Note that in the average of the spatial correlation, the shape of the 2-D correlation function is elongated along the x-coordinate. This feature indicates that there is a correlation along adjacent pixels (x-coordinate) and far less correlation with adjacent lines (y-coordinate).

To determine the diffusion coefficient of the particles:

64 Press the “Fit” button (Fig. B6).

A new window (2D-ICS) opens (Fig. B7).
65. Set the values of the different parameters for the fitting as indicated in Fig. B7 (Box). Initialize the background parameter to a non-zero value for example 0.0001

66. Press “Perform fit” button

A new window open with the 2D-gaussian, and the fitted parameters will appear at the bottom of the 2D-ICS window (Fig B8, -).
You should understand the values you have used:

**Raster scan**: selects models related to the RICS mode.

**Size of image to analyze**: Limits the size of the 2D function to be calculated. This value should be the smallest that contains the region where the correlation function is different from zero.

**Pixel time**: this value is in microseconds and is the pixel dwell time.

**Line Time**: this is the time in milliseconds between consecutive lines in the scan. The Line Time is not simply the product of the pixel dwell times and the number of a pixel in a line. Depending on the instrument being used and the scanning settings, there are added delays between lines in which the trace is not active. These additional delays include programmed line waits, beginning and end, and retracing time; they can add a substantial amount to the line delay.

**Frame time**: only used for time correlation. Also, there is a time delay between lines and at the end of frame. This value must be given to you by the software you are using.

**Radius**: only used for the circular scanning FCS. It calculates the distance between pixels along the circular orbit.

**Points in x to jump**: This is a very important parameter for the fit!!! In most analog detection systems, the intensity at one pixel carries over the intensity at the next pixel. This gives the appearance of a spatial correlation, which of course is only due to the electronics of the microscope. A value between 3 and 5 is sufficient to suppress the effect of this electronic correlation.

**Pixel size**: this is in microns, the distance between pixels. The software of your microscope should give you this value. Remember that this value should be smaller than the waist of the PSF for spatial correlations to be detectable.
Wo: this is the $1/e^2$ value for the Gaussian approximation of the PSF. It is consistent with the simulation part of SimFCS.

All the other parameters refer to the particular fit to be performed. In the RICS mode of data analysis, you can fit 2 diffusion components and one exponential component.

The “use weights” flag uses the standard deviation matrix that was calculated during the averaging of the many frames that contributed to the average spatial correlation.

The “use 2D diffusion” and the “use 2-photon formulas” are used to load the 2D diffusion term into the function and the 2-photon diffusion term instead of the 3-D term and single photon diffusion formula.

The 3 buttons calculate surface, perform fit and STOP, just do what they say.

The fitting radio button allows choosing the entire 2D correlation or only the horizontal or vertical section of the surface. For cross-correlation, the function is non-symmetric, so that the button should be in the non-symmetric function choice.

The STICS spin edit field, allows visualizing the different data and fitting planes of the STICS operation.

The check limits check allows performing fit without checking for unphysical values, such as negative diffusion values or similar impossible cases. However, during minimization, the computer could try an impossible value during the search for a minimum. By selecting this checkbox, the search will be stopped when an impossible value is reached. We suggest that you experience with different conditions, but always check for the validity of the results.

The chi-square value is normalized only if the use weights flag is set. Otherwise the software uses a value of 1 for the weights, giving very low chi-square values. In this case, only the ratio of the chi-square when using different models should be used as a comparison.

When the fit is done, the best fit 2-D function is shown. You can select showing the residues of the fit or the original data. In either case, the resulting 2D surface can be manipulated, rotated and copied to the clipboard, using the chart editor.

You can play with some of the parameters for the fit. For example, try the use weights flag. In this case the chi square should be normalized and should be closer to one for a good fit. However, if all points are treated equally, there is a disproportionate amount of points which are zeros, outside of the region of correlation. The computer will try to fit these points, neglecting the points which are important, namely these of the correlation function. For this reason, we don’t recommend using this flag.

**Exercise B2: Simulation using circular scanning**
Set up the simulation as you did for exercise B1, but at the tab for “Time/scan” (Fig. B9):

67. Select “Scan circle”

68. Input 20 for the “Radius of scanning”, the orbit.

Because the simulation units are 0.05 um, a radius of 20 is equal to a radius of 1 um in “physical” space. The length of the orbit is then 6.28 um. Since we have 64 points along the orbit (why? Please try to respond to this question), the sampling points are spaced at 6.28/64= 0.0981 um. The points are overlapping with respect to the PSF which has a waist of 0.25 um.

Run the simulation by selecting “Start simulation” and then “Isotropic Diffusion” as in exercise A1 (Fig. A9):

C. Analyzing the Data:

57. Click “Analysis” under the main SimFCS screen, on the top menu (Fig. B3).

58. Select “RICS” from the pull-down menu.
Move the spin edit for frame 1 and note that the pattern on the screen is different now. Of course, these are not raster scan data, but circular scan data!

71. In the “ROI” tab set “Size”, “ROI analysis” and “ROI reading” to 64 and leave “Frames to process for ACF” at 100 (Fig. B4).

72. Calculate the “RICS” function in the “Tools” menu using the “Subtract average” option (Fig. B5).

Note the different shape of the spatial correlation with respect to the raster scan case (Fig B11). Can you explain why it is different?

73. Go to the fit page (Fig. B11).
74._Chose the "circular scan" function (Fig. B12).

75._Enter 20 for the scan radius (Fig. B12).

76._Set other parameters as indicated in the box (Fig. B12).

77._Perform the fit (Fig. B12).
A window with the 3D Gaussian and the fitted parameters will appear Fig. B13
The value of $D$ for my simulation is close to the target (Fig. B13). The residues are small and the chi-square very good. It will be interesting to see what you obtain!!

**Question:** Could we have analyzed the same data using the scanning-FCS screen?? What will have been the major difference??

**Carpet representation**

To display the simulation in a carpet representation:

1. **Close the RICS page** (Fig.B14).
2. **Click “Analysis” menu** in the FCS screen (Fig.B14).
**80** Select the “**Scanning FCS**”.

A new window will pop up (Fig. B15):
Press the “Calculate image” button (Fig. B15).

The simulation will be displayed in a carpet (Fig. B16). The “carpet” horizontal lines are the single circular scans and the x-axis, then, is made up of the points within the orbit, 0 to 63, show below. The successive scans are then drawn underneath, creating the semblance of additional threads being added, from top to bottom, to a growing carpet. Drawn in this manner, the columns of the carpet contain the intensity time series for each of the physical points in the defined orbit.
Analysis of the columns

In this screen (Fig. B16), we can analyze the columns of the carpet. For example, we can select one column, calculate the ACF at that column and then perform a fit of the column ACF.

82_In the “Trace ACF” tab:

83_Select 32 at the “Points from edge” field.

This selects the middle column of the carpet.

84_Press the “ACF at trace” button.

A small window SimFC20 will show (Fig. B17) indicating the maximal length for the large vector correlation.
85_ Click OK.

You are automatically transferred to the large vector correlation page (Fig. B18) with the buffer filled up with the data from the column you selected.

86_ Set the FFT length to “16K”

87_ Select “Ch1 autocorrelation”.

88_ Press the “Calculate” button.
The autocorrelation at channel 1 will be calculated.

Once the autocorrelation curve appears:

89_Press the “fit” button.

The ACF curve-fitting (corrfit window) interface will pop up (Fig. 19).
90. Set the parameters as indicated in Fig. B19.

91. Click on “Perform fit”.
The fit is excellent (Fig B20) and the recovered value for $D$ is about 10 μm$^2$/s.
What about the $G(0)$? Will the $G(0)$ obtained using the RICS approach and the $G(0)$ from fitting each column be the same?

Exercise B3. Line scan analysis of adhesions

In your memory drive you should find the file “pax1023.bin”. This is a file collected by Michelle Digman using the circular scan mode at the focal adhesion shown in Fig B21. The protein is paxillin-EGFP and data were collected with a 2-photon scanning microscope.

![Image of a graph with coordinates and measurements: Field of view 15.6 μm, Scanning radius is 7 pixel=0.426 μm, Length of the orbit is 2.68 μm, 64 points is the orbit, Distance between adjacent points is 0.044 μm, Orbit period 1ms.]

Fig B21

Go back to:

79. Click “Analysis” menu in the FCS screen (Fig.B14).

80. Select the “Scanning FCS”.

In the new window (Fig. 22B):
92. Go to the “File” menu.

93. Select “Open*.bin file (read all channels)” to open the file in *.bin format.

Nothing new shows up in the screen

94. Set “Points per period” field to 64.

95. Set the “Periods to average” field to 1000.

96. Depress the “calculate image” button.

You should see the scanning FCS carpet shown in Fig. B23.
It is easy to see that the intensity of the carpet, more specifically the central bright region, changes as a function of time (going from top to bottom of the carpet). We would like to have a data set with no slow intensity changes that distort the analysis results and obscures the faster fluctuations of the paxillin molecules. We can do this with the procedures for detrending data in SimFCS:

97 In the menu, select “Carpet analysis” (Fig B23).

A new window “Carpet analysis” pops up. In this window (Fig B24).
98. Set "Sampling freq (line)" to 1000 [=1/line time (s)].

99. Change the "moving average" field to 10000 points.

100. Check “Use moving average immobile removal” box

101. Press the “Set detrend” button.

A new window “detrendform” appears (Fig B24). In this window:

102. Select the option “segment random numbers” from the select method group, and
103. Select the “Store detrend data in huge 2” checkbox.

104. Close the “detrendform” window.

105. Select “Detrend Only” in the drop window of the carpet analysis (Fig B24)

106. Press the “Analyze” button

The detrended carpet will appear in Channel 1 (Fig B25).

What is happening here is that every column is divided in segments of 10000 points. For each segment the average is calculated. The largest average is stored. For each segment, random “uncorrelated” numbers are added in a quantity that will make the average counts in each segment to be the same. After this operation all trends should have disappeared. However, since different columns have different average, the difference in intensity in the columns will be preserved.
Questions:

In which way, if any, the addition of random numbers will affect the statistics?

In the “Set detrend” option screen, there are various ways in which the columns could have been filtered. For example, calculating a moving average and subtraction the moving average at each point in the column, or subtracting an exponential average. Instead, you were told to use the random number addition mode.

1. Will any other method of data detrend have worked?
2. What is special about this data?
3. If the data was produced in the confocal microscope with analog data detection, which method should I use?

Be sure you understand what is going on here, otherwise the entire analysis could be ruined!

Now we can select columns and perform the ACF calculation in selected columns, in selected columns range or in the entire carpet. For example (Fig B26):
107. Select points from edge 32 and edge width=4.

This means that column 32 plus 2 columns in each side are selected and combined for the ACF analysis.

108. Press ACF at trace.

A small window SimFC20 will show (Fig. B27).

109
109. Click OK.

You are now in the large vector correlation page (Fig B28)

110. Select a length of 16K for the ACF calculation.

111. Perform the ACF calculation.

112. Click on “Fit”.

In the corrfit window (Fig B29):

113. Set “Wo (um)” to 0.25 and Ratio (Wz/w0) to 4.37 and all other parameters as shown in Fig B29

114. Click on “Perform fit”
If you had previous plots in that page, thing can appear messy. Ask for help how to erase previous graphs. Otherwise just proceed with the fit procedure. After the fit, the plots will be autoscaled.

Clearly, we can easily observe the fast relaxation due to the occupation number of the paxillin molecules at the adhesion. The apparent diffusion is about 1.4 \( \mu \text{m}^2/\text{s} \) and the \( G(0) \) is very small.

Try to do the same analysis without detrend. The ACF will be dominated by the slowly varying intensity and the fast process will be very difficult to discern.

In our analysis we averaged several columns. It is possible to analyze each column individually, save the data and import in Globals for analysis. It also possible to automatically calculate the ACF at each column and perform a single component analysis at each column and display the \( G(0) \) and \( D \) in a form of a plot. If you are interested (Fig B30).
Go to the Carpet analysis page.

Select the function “Column ACF” in the drop-down menu.

Press “Analyze”.

The ACF will be calculated at each column. It can take 1-2 minutes. Then

Press “Fit”.

The fit page will appear. This is to initialize the fit. All columns have been averaged so that the “average fit” can be done. Select the function you want, for example (Fig B31):
119_ "Autocorrelation1" single component fit.

120_ Press “Perform fit”.

This will fit the “average column”.

To fit each column separately:

121_ Close the fit window.

The window will flash each time a column is calculated. After the last column is calculated a plot of the G1 (red) and D1 (green) will appear in the lower right corner of the carpet window (Fig B32).
Outside columns 20 to 45, the fit gives very unstable results. The reason is that there is no adhesion in this region, and we are just fitting the noise. However, in the region with the adhesion, $D$ is in the range of 0.5 $\mu$m$^2$/s, on the average smaller in the right part of the adhesion and the $G(0)$ is around 0.02, again being smaller on the average in the right part of the adhesion.

**Exercise 4B. RICS analysis of cell images**

Go back to:

57_Click “Analysis” menu in the FCS screen (Fig.B3).

58_Select the “RICS”.

In the new window (Fig B33):
122. Go to the “File” menu.

123. Select “open multiple images (int, tif, ...)

124. Select the image sequence 4-22-03-#2-A5-CHO-CELL3B.tif.

This file is a stack of 100 images of an alfa5-EGFP integrin in a CHO cell collected by Claire Brown on an Olympus FluoView 300 at the University of Virginia.

The TIF verify window (window title: vch34ve) will pop up (Fig B34). This window gives some of the parameters found in the header of the file.
After closing this window, the data are read into a 256x256 region of interest (ROI). At the end of the reading operation, in the lower left image, you should have a region of interest selected by a box. (Fig B35)
126 Move the box to the center of the image and press the reprocess button.

This selects the data in a 256x256 square in the region of interest.

To reprocess the data:

127 Set the moving average to 20 in the RICS.

Only the correlation due to the mobile part is left. All contributions from the immobile fraction are removed. To convince yourself, just perform the same operation without removing the immobile fraction.
**Question:** What was the criterion used to choose moving average using 20 frames? Can we just have removed the immobile fraction? Try the different modes to see the differences caused by these modes of data analysis.

128 Go to the Read tab (Fig B36).

![Fig B36](image)

129 Click on “Reprocess ROI” button (Tools -> Subtract moving average)

A new “verify TIFF” window will open. After closing (125, Fig B34) the images are processed.

130 Click on “Fit” (Fig. B37).
131. Set the parameters of the fit as shown below, in the “2D-ICS” window

- Size = 32
- Pixel time = 8.000
- Line Time = 5.00000
- Frame Time = 1
- Radius = 0.00000
- Pixel size = 0.092000
- \( Wo (1/e^2 \text{ in um}) = 0.30500 \)

132. Click on “Perform fit” button.

The fit is excellent (Fig B38); the apparent diffusion constant recovered is in the 1 \( \mu m^2/s \) range. You can play with other parameters for the fit and select different models.
The fit is excellent; the apparent diffusion constant recovered is in the 1 μm²/s range. You can play with other parameters for the fit and select different models.

The next question is about determining if there are small regions of the image in which we can see aggregation of the integrins. For this, we go to the next exercise.

Exercise B5. Simulation of N&B data

N&B analysis allows you to extract spatially-resolved particle number, <N>, and particle brightness, B, information from an image. There are two types of simulations you can perform to test the N&B analysis:

1) You can simulate particles of different brightness and numbers. In addition, you can simulate either analog or photon counting detectors. In this simulation type, the image is uniform, and you cannot test the N&B ability to separate regions of different brightness.

2) You can set regions of the image called T-zones in which particles have different brightness depending on the position relative to the zones.
To perform the first type of simulation (not spatially-resolved) you must enter the parameters for the brightness, box size(?), detector type, and scan specifications. The following example illustrates this first type of non-spatially resolved simulation.

Setting up the simulation:

Repeat steps 1 to 3 of exercise 1A:
1. Open SimFCS (Fig. A1)
2. Select “Simulate FCS data” in the action panel at the left had side of the screen (Fig A2).
3. Select “Parameters” from the menu at the top of the screen (Fig. A3).

PST Tab:

133 Set parameters as in Fig B39

PSF

![PSF Simulation Image](image-url)

Fig B39
**Particle Tab:**

134. Set 200 particles of 100,000 c/s/m and D=20 µm²/s (Fig B40):

![Particle Tab](image)

**Misc Tab:**

135. The detector is set in the photon-counting mode which is the default value unless “Use analog detector” is selected. (Fig B41)
Time/scan Tab:

136 Select Raster scan with a grid of 256x256 points (Fig. B42).
Time/scan

![Image of Time/scan settings](image)

Fig B42
Running the Simulation:

Go back to:
19. Click on “Start_simulation” at the top of the simform window (Fig. A9):
20. Select “Isotropic diffusion” from the pull-down menu. (Fig. A9):

Then to:
57. Click “Analysis” menu in the FCS screen (Fig.B3).
58. Select the “RICS”.

137. In the “Tools” menu select “N and B” and “No detrend” (Fig. B43).

Fig B43
N and B analysis

In the RICS screen (Fig. B44), you have 2 maps corresponding to:

- a) Variance/Intensity (or apparent brightness, B)
- b) The average intensity.

For this analysis the smooth button was used once.

Observe the histograms of the B value (Fig B45, a) which is slightly biased towards larger B values and of the number of particles (Fig B45, b) which is approximately Gaussian.
138 Go to the Math Tab (Fig. B45).

Note the values of “True n” and “True e” in the “ICS” screen above (Fig B45, ⭐) shown above. These values are always calculated.
Note also the ratio of "variance/intensity", which is larger than 1, indicating that the particles are moving.

**Question:** Can you explain these values on the basis of the parameters used for the simulation? What is the dwell-time? What are the units of true?

**Spatially-resolved N&B**

In this simulation particles are constrained to be in a plane. The plane is divided in zones where the particles are transiently confined. In the zones, the particles can diffuse slower than in the rest of the plane and they can have a different brightness. The zones are periodic.

You can set:

1) The size of the zone.
2) the distance between the centers of the zones.
3) The diffusion ratio between the particles in the zones and in the rest of the plane.
4) A probability of escaping from the zone.
5) The center of the first zone can be placed in every point of the plane.

Go back to Simulation at the beginning of the exercise B-5.

139 Go to the “TZone 2D” tab (Fig B47).

140 Set the parameters as indicated in Fig B47.
According to the values chosen, the TZ does not affect the number of particles or the diffusion, since the diffusion ratio is 1 and the probability to jump out is 1. It only affects by a factor of 2 the brightness inside the T-zone. The brightness ratio can be any number, including 0.

141. In the “Start simulation” tab use the “TZ diffusion in a membrane” (Fig B48). Entry for this simulation rather than the “Isotropic diffusion”.

139

Fig B47
142. Click “Analysis” menu in the FCS screen (Fig. B49) and select “RICS”.
Go Back to:

137_In the “Tools” menu select “N and B” and “No detrend” (Fig B43).

For the above values you should get the N&B analysis as shown in Fig B51. Data are shown for the “variance/intensity vs. intensity” analysis.

“variance/intensity vs. intensity” maps

143_In the main RICS window, click on “Appearance” to show plot titles (Fig B50).
In the ICSapper window that pop ups, check “Show axis for panels” and (0,0) interpolate.

The Variance/Intensity map shows that T-zones are characterized by higher apparent brightness.

This is better seen in the N&B window (Fig. B51). The cursor (red circle) can be positioned to select only those image pixels whose apparent brightness (B) and intensity fall inside a certain region.
N&B analysis in cells

Example 1

Go back to the “Sim_fcs” window:

142 Click “Analysis” menu in the FCS screen (Fig.B49) and select “RICS.

145 In the “ROI” tab set “Size”, “ROI analysis” and “ROI reading” to 128 (Fig.B52)

146 In “File” Select “Open Image sequence (Bin)” and open the file “paxillin013.bin”.

Fig B51
When the “Raw form” window appears (Fig B53):

147.Select “Width” and “High” to 128

148.Check **16-bit integer** and close the window.
An image will open in the RICS window (Fig. B54)
The “paxillin013.bin” file contains 500 frames (128x128 pixels). The time interval between frames is 1.23 s and the pixel dwell time was 50 μs.

This file shows a region of a retracting edge of a cell expressing paxillin-EGFP. It is believed that paxillin is monomeric in the cytosol, it aggregates as a monomer the focal adhesion and it detaches from the adhesions as a small aggregate of about 8-10 molecules when the cell retreats. The disassembling of the adhesion is a dynamic process. It was recorded in action during the measurement of this movie. The first 100-200 frames show the disassembling process while the rest of the movie shows a more quiescent cell.

We will analyze the file as a whole and then dividing the overall record in pieces of 100 frames at a time.

To carry out the N&B analysis:
149 Go to “Tools” and select “N&B” and “No detrend”

A new window opens (Fig. B56)
The images showing the average intensity and the brightness (variance/intensity) maps (Fig B56) can be seeing in the main RICS window. The number in parenthesis show the min-max of the color code used.
The dots in the B vs Intensity plot (Fig B56), appears somewhat dispersed. It is possible to get a clearer selection map by applying a filter (Fig. B58):

1. In the “Filters” tab click on the “Smooth” button.
Now we can select the region of the image containing monomers or aggregate. This will easier if we adjust the size of the B axis to the values obtained. For this (Fig. B59):

152 Type the adequate values for X and Y

Fig B58

153

Fig B59

151
Uncheck the "Autoscale" box

Press the "Recalculate plots" button.

**Selecting monomers in the cytoplasm.**

In the "View" tab uncheck "Change cursor position on refresh" (Fig. B60).

Then (Fig. B61):
154_Set the cursor type as a rectangle.

155_Set the size of the cursor as indicated and

156_Position the cursor at B ~1.04.

In the image in the selection map, monomers appear in red (Fig. B 61)

**Selecting aggregates >5 monomers.**

157_Increase the y-size value of the cursor.

158_Position the cursor at B ~ 1.3 (Fig. B62)
The average brightness of a monomer from B=1.035 and pixel dwell time 50 us is 700 c/s/m. At the disassembling adhesion the brightness is quite heterogeneous with an average of B=1.27 which corresponds to about 5480 c/s/m or 8 monomers.

Analyzing frames intervals.

It is possible to analyze different intervals of the stack of images taken. For instance, if you want to analyze frames 1 to 99, in the ROI tab of the main RICS window (Fig B63):

159 Set “Image 1 frame” to 1

160 Set “Frames to process for ACF” to 99.

Similarly, to analyze frames from 200 to 299 you set “Image 1 frame” to 1 and “Frames to process for ACF” to 299.
In this way it is possible to get “Movies” as those shown in Fig B64.

![Movies of adhesions assembling-disassembling](image)

The intensity trends shown in the lower part of Fig B64 can be obtained by clicking in the images of the main RICS window (Fig B65). The graph can be smoothed by:

161. Pressing the function button and
162. Selecting “Smooth all graphs”

Example 2

In the RIC page (see Fig B66)

163. Go to “File” and select “Open multiple images (int, tif,..)”. Load the file “4-22-03-#2-A5-CHO-CELL3B.tif”.

Fig B65
Close the “Raw form” window shown in Fig B67:
When the file is opened, the cursor will show in the upper left corner of the image (Fig. B65a).

To detect α5-integrin clusters, we must examine the periphery of the cell.

165_ Select the lower part region (Fig B65,b) and open the file again.
The images will change as shown in Fig B69:

Click on “Reprocess ROI” button.
To carry out the N&B analysis:

Go to “Tools” and select “N&B” and “No detrend” (Fig B55).

A new window will appear (Fig B70). This window shows the N&B analysis with the default parameters. These parameters need to be changed according to the method of image acquisition used. Since this file was acquired using an analog system (Olympus FluoView 300) the detector gain and offset need to be calibrated. The values entered for offset, S and sigma0 were obtained from the calibration procedures:
166 Go the “Cal” tab (Fig. B70) and

167 Set the parameters as shown in Fig B71
Press the “Recalculate N+B” button.

This will recalculate N+B utilizing the new values of the parameters.

You may adjust the axis of the plot to the new analysis. Go back to (Fig B59):

Uncheck the autoscale

Type the adequate values for X and Y

Press the “Recalculate plots” button.

To visualize the α5-integrin clusters, you may (Fig B72):
169_Set the cursor type as a rectangle.

170_Set the size of the cursor as indicated and

171_Position the cursor at a high value of B (~1,4)

The N and B maps can be seeing in the main RICS window. These maps can only be obtained using the N/B mode of display. For this (Fig. B73):
Go to the “Math” tab and check “<N> and B (moment analysis)”

After this go to the main RICS window to see the N and B maps (Fig B74):
The program always produces two maps of the two variables selected. If you select variance/intensity (B) vs. intensity, the B map and the intensity map will be shown, but if you select N and B then the N map and the B map will be shown.

We can start to distinguish the bright spots at the cell border where the integrins are presumably aggregating. In the N&B page move the cursor in the right side in the 2D histogram figure. The points contained in the cursor (the circle) will light up in the image. For better view, select the parameters as shown in the figure above.

Now you can explore the region of large brightness and low number of particles. You can also use the 1D histogram of B and Intensity to simultaneously select regions of a given brightness and intensity.

Note that the brightness in the average lowest brightness of the part of the membrane without the larger aggregates corresponds to about 0.114 (B=1.114) while at the points of the larger
clusters the brightness is about 1.409. If the calibration was correct, the aggregates contain about 3 units of the smaller units. It is not known if the smaller units are monomers, presumably not. The pixel dwell time for this file was 8 µs. Therefore, the brightness of the small aggregates is about 14250 c/s/m, a relatively large value to be an EGFP monomer. The laser intensity was 1% according to the file header.

There many other features and possibilities in this screen. Too many to explore in this brief time allocated for this exercise. If you are curious, you can ask the assistants.

Have fun!!!
C. Fluorescence Lifetime Imaging (FLIM)

Phasor Properties

The phasor is a frequency domain representation of the fluorescence lifetime at a single frequency. For single exponential lifetimes, this completely describes the system. For multiple exponentials, the phasor represents some intensity weighted linear combination of the lifetimes in the system. Therefore, given the phasor for a single multiexponential measurement, we cannot determine the lifetimes for the system. Nevertheless, given multiple measurements (e.g. multiple pixels in an image), heterogeneity becomes obvious.

To demonstrate this effect, use the attached Microsoft Excel worksheet (Phasor_Sim.xls) which calculates the multi-frequency fluorescence modulation and phase curves, the time domain fluorescence decay, and the phasor at a single frequency for a combination of four exponentials.

Two State Equilibrium

Fluorescent ion indicators often exist in two distinct states with different emission spectra and fluorescence lifetimes (and sometimes absorption spectra). The lifetime may be multiexponential in both the free and ion-bound state. Binding to the ion of interest shifts the equilibrium between these states, changing the spectral properties and the fluorescence lifetimes. Therefore, the free and bound states will be characterized by different “phasors”. Close to the dissociation constant, the fluorescence lifetime is characterized by a linear combination of the two phasors.

Simulate the phasor for different combinations (relative amplitudes) of a 4 ns lifetime state and a 1 ns lifetime state (e.g. amplitude 1 = 0.2, amplitude 2 = 0.8).

Record S (the phasor y coordinate) and G (the phasor x coordinate) values for each combination.

Plot S vs. G to see how the phasor changes with different combinations.

Questions:

-When half of the population is in the 1 ns state, has the phasor moved halfway between the phasors for the two states?
-Does the position of the phasor change linearly with concentration?
-What about with fractional intensity?
-What information would you have to have in order to calculate concentration from the position of a phasor?

The file, capillaries1001.ref, contains phase and modulation data on three capillaries filled with different dye solutions.

Enter to the FLIM analysis menu:
1. Click on **FLIM** module in SimFCS (Fig. C1).

![SimFCS 2.0 interface with FLIM module highlighted](image)

Fig C1

* A set of windows will open (Fig C2).
2. Under the “File” menu, click “Read referenced and add” and then open the file “capillaries1001.ref” (Fig. C3).

This file contains phase and modulation data on three capillaries filled with different dye solutions.
Referenced simply indicates that this file has been corrected for phase shifts and detection efficiency relative to a reference with a known lifetime (i.e. fluorescein).
3. At the top of the screen the image is shown in false color (you can change this to grey scale by unchecking “Color points” and pressing the “Recalculate” button (Fig C4).

The two phasor plots show the pixel phasor distribution for the first (lefthand plot) and second (righthand plot) harmonics (for the two-photon systems these would be 80 MHz and 160 MHz)
The calculation of the phase and modulation is strongly dependent on the signal-to-noise. Therefore, it is a good idea to smooth noisy data by a moving average. This can be done using the 4_Smooth button (E-button) (Fig. C4).

Note that this will also reduce your spatial resolution in the phasor.

To visualize better the phasors in the plot you can change the color of the black background by 5_Checking “White background”.

![Fig C5](image-url)

If you need high spatial resolution, make sure you have at least 100 photons in each pixel of the image.

In addition, small amounts of room light will appear towards the lower left-hand corner of the phasor (room light is uncorrelated, so it has zero modulation depth). This can be eliminated by setting a threshold. Click Recalculate to update the image with the new threshold. Note that if the room light is significant compared to the fluorescence signal, it will bias the fluorescence phasors by pulling them toward the lower left hand corner of the phasor plot, with phasors corresponding to lower intensity regions of the image being pulled more toward the lower left hand corner than those of higher intensity regions of the image. Different components of the phasor can be selected in the image by clicking and dragging the cursor in the phasor plot. Above the phasor, the phase and modulation for the cursor is listed as well as the apparent phase and modulation lifetimes for these components.

All of the capillaries contain 10 mM Tris buffer, pH 8.0. Fluorescein has a lifetime of 4.05 ns in basic solution.
Which capillary contains fluorescein?

The shortest lifetime capillary contains Rhodamine B. Rhodamine B has a single exponential lifetime around 1.5 ns in phosphate buffer at pH 7.0.

Is Rhodamine B single exponential in this solution?

Can you guess what the center capillary contains?

You can have many phasor cursors by selecting different colors under the “cursor” tab. This would allow you to have different phasor distributions displayed simultaneously. You can click on the “On” checkboxes next to your desired color to activate the cursor. To demonstrate this feature (Fig. C6):

Fig C6

6. Check the “green” box.

At this point, when you click on the plot, a green cursor will appear at the (0,0) position of the phasor plot. If you do not see it move the red cursor.

Now you can move the green cursor around the point clouds to highlight the pixels in the image that correspond to this specific phasor distribution.
Another feature here is the possibility of mapping (linking) the linear combination (fractional intensity) of two different lifetime signatures associated with two different species. In our example:

7. Check the “link” boxes (Fig. C7) next to the selected colors (in our case Red and Green).

![Fig C7]

At this point the two colors (species) are linked together. In order to visualize the linear combination of the two colors (species):

8. Place the 2 cursors on the part of the image you want to link

9. Go to “Tools” and under “show cursor bitmap” select “cursor harmonic 1” (Fig C8).
At this point you have a color map of the relative concentration of the species you have selected.
The explanations in the last two paragraphs should help you answer the last question above, about the components in the middle channel.

**Quenching**

In this section, we will discuss quenching due to FRET. The efficiency of energy transfer is related to the fluorescence lifetime as follows:

\[
E = 1 - \frac{\tau_{DA}}{\tau_D}, \quad \text{or} \quad \tau_{DA} = \tau_D (1 - E),
\]

where \(\tau_{DA}\) is the lifetime of the donor in the presence of acceptor (quenched) and \(\tau_D\) is the lifetime of the donor in the absence of acceptor.

Calculate the phasor for a fluorophore with a 4 ns lifetime. Now calculate its phasor under different efficiencies of energy transfer. How does this differ from what we saw with the two-state system?

If one can preferentially excite the donor fluorophore (no direct excitation of the acceptor) and observe the acceptor fluorescence, a very unusual phenomenon is observed. The fluorescence of the acceptor rises with the same time constant as the quenched donor fluorescence. Then it decays with the characteristic lifetime of the acceptor. For example, the case where the donor lifetime has been quenched to 0.5 ns and the acceptor lifetime is 4 ns would be simulated for the acceptor by a lifetime of 0.5 ns with amplitude of -1 and a lifetime of 4 ns with amplitude of 1. Can you simulate this case?

Often in FRET experiments, only a fraction of the donors experience FRET. The others continue to fluoresce with an unquenched lifetime. Simulate the situation where 50% of the donors remain unquenched. Rationalize the results in terms of the quenching simulations done above and the two state experiments we did earlier.

10. Go to “File” and select “Clear all images”.
2. Using the **Read referenced and add** (Fig. C3) open the file “CFPpax8651866.ref”.

*This file contains referenced FLIM data for a cell transfected with a CFP paxillin construct.*

2. Also using the “Read referenced and add” open the file “1011rac1002.ref”,

*This second file contains referenced FLIM data for a cell transfected with a CFP-YFP fusion protein.*

The second image will appear at the top of the screen, and the phasor histogram points from that file will be added to the phasor plot. A screen image of the two files loaded into the FLIM page is shown in Fig. C11. The phasor distributions are plotted together in the phasor plots.
11. Set threshold to 31

This is to remove any room light.

12. Click on the “E-button” to smooth the phasor.

It may be helpful to toggle one of the images for visual comparison.

Analysis of FRET trajectories from Lambert’s instrument files
1. From the SimFCS FLIM screen (select Tools and click on “clear all images” to remove the previous data). Load the following two files available in the tutorial directory:

CFP and CFP-YFP.ref
CFP-YFP many cells with background.ref

These two files were acquired using the Lambert frequency domain FLIM instrument. They contain fixed samples of CFP and CFP-YFP expressing cells with various amounts of background.

These two files were referenced using a solution of fluorescein at pH>9.

Note that the “>Image threshold” is set to 6202 counts so that we can see the background phasor. Just slide the cursor next to “Image threshold” and the image will be recalculated as you move it.

2. Click on “white background” to have the phasor plot as shown in the image above.

Before starting the analysis of the FRET trajectory, we need to identify the phasor of the donor without the acceptor and the phasor of the background or autofluorescence.

In the expanded view below these two phasors are identified. To expand the phasor plot, click on the + - and the arrows to move the zoomed region to the center of the graph. For the following analysis set the cursor size to 0.03. Move the cursor to the phasor of the donor (red arrow) and then in the assign menu select “assign to unquenched”. Then move the cursor to the background phasor (blue arrow) and press “assign to background”.

3. Set the cursor size to 0.03 and move the cursor to the phasor of the donor (red arrow) and then in the assign menu select “assign to unquenched”. Then move the cursor to the background phasor (blue arrow) and press “assign to background”.

4. The phasor plot should now be displayed as shown in the image above.

5. To analyze the FRET trajectory, click on the “FRET” menu and select “FRET analysis”. Then select “FRET analysis” and set the threshold to 0.6. The FRET plot should now be displayed as shown in the image above.

6. To further analyze the FRET trajectory, click on the “FRET analysis” menu and select “FRET analysis parameters”. Then adjust the FRET parameters as shown in the image above.

7. The final FRET plot should now be displayed as shown in the image above.
The red arrow indicates the position of the CFP phasor and the blue arrow the phasor of the background. You can verify that if you change the threshold, this region of phasors assigned to the background disappears. You can also use only one file at a time to better recognize the phasor of the CFP, CFP-YFP and background.

3. Now go to the calculator menu and select “FRET (donor only)”. You can change the level of threshold so that the signal from the cells has better contrast with respect to the signal from the background.

The calculator shows two trajectories (selected by scan FRET efficiency and scan % background), one for the quenching due to FRET and the other for the superposition of the FRETing population with the background.
The FRET efficiency for the file with very little background is about 0.23.

Instead, the best agreement for the file with large background is obtained with the combination shown below, that results in about 0.32 FRET efficiency.

Note that in this analysis the threshold was increased to 8000 to see less of the background. For this sample, it seems that all the cells are FRETting and that the change of lifetime between the cells is due to combination with the background fluorescence.

Another type of plot that can be obtained is the histogram of the fractional intensity, along the green line, for each file selected.
Fractional intensity = 0.348 Score= 0.210

4. Assign component 1 and component 2 to the extreme of the line of the linear combination (the green line). Then in the “tools” select “linear formula of file selected”.

You will notice that there is another entry in the menu for producing the fractional contribution of FRET efficiency. This is calculated along the yellow FRET line. At the time of this writing, this feature is not yet active.

**General comments and questions:**

In some of the files there is a large amount of background, which is absent in other experiments. I believe this is due to the media used for fixing the samples.

The spatial distribution due to FRET is always obtained at the entire cell level, not internal to a cell since in these samples either a cell expresses one protein of the other.

What percentage of the species is FRETing in the CFP-YFP image?

Is the FRET efficiency high or low?
D. Particle Tracking with SimFCS
(… a basic walk-through tutorial)

This tutorial is conceived as a basic walk-through to demonstrate the particle-tracking features built into the SimFCS package. At the end of this walk-through you should be able to:

a) Simulate different scenarios for particle motion (2D, 3D, multiple particles, random motion, motion along a specified trajectory, etc.).
b) Understand how to use the basic elements in the particle tracking screen to obtain the trajectories of the simulated particles.
c) Use the trajectory analysis tool to obtain basic parameters and plots from the recorded data.

The simulation tool built into the SimFCS program can be used to evaluate how well the instrument should perform under given conditions (noise levels, instrument astigmatism, particle concentration, etc.).

1. Introduction

The particle tracking portion of SimFCS is accessed by checking the “track particles” option in the main SimFCS screen (as indicated by the red circle in the screenshot below).
The particle tracking screen opens, and the sheer quantity of controls for the different parameters may seem intimidating at a first glance. Before going into the description of this page and the meaning of the relevant parameters – which will be used to perform the actual tracking - let us turn to the motion scenarios to be simulated.

2. Simulation settings for different particle motion scenarios

The simulation parameters are adjusted in the same way as described in previous tutorials, in the “simform” window. It can be accessed from the particle tracking screen under the “Options” menu -> Particle parameters (red circle in screenshot below) or also from the main SimFCS screen (under “simulate FCS data”).

In the simform, most of the parameters will already be set properly. Pay attention, however, to the following settings highlighted under “PSF” and “Misc” Tabs:

The settings for the motion of the particle(s) are adjusted in the “particles” section of the “simform” (see screenshot below). To make things easier in the beginning we choose to simulate a single (#mol = 1), slow (D = 0.05) and bright (Br1 = 100,000) particle. We turn to more complex cases later.
After closing this window the simulation parameters are set and we can go to the tracking screen.
Before starting, please check under “Calibration”, “Calibrate galvo response”, that the calibrations parameters are set as follows:

<table>
<thead>
<tr>
<th>X-axis</th>
<th>Y-axis</th>
<th>Z-axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period</td>
<td>Amplitude</td>
<td>Phase</td>
</tr>
<tr>
<td>128.0</td>
<td>1.000</td>
<td>90.0</td>
</tr>
<tr>
<td>256.0</td>
<td>1.000</td>
<td>90.0</td>
</tr>
<tr>
<td>512.0</td>
<td>1.000</td>
<td>90.0</td>
</tr>
<tr>
<td>1024.0</td>
<td>1.000</td>
<td>90.0</td>
</tr>
<tr>
<td>2048.0</td>
<td>1.000</td>
<td>90.0</td>
</tr>
<tr>
<td>4096.0</td>
<td>1.000</td>
<td>90.0</td>
</tr>
<tr>
<td>8192.0</td>
<td>1.000</td>
<td>90.0</td>
</tr>
<tr>
<td>16384.0</td>
<td>1.000</td>
<td>90.0</td>
</tr>
<tr>
<td>32768.0</td>
<td>1.000</td>
<td>90.0</td>
</tr>
<tr>
<td>65536.0</td>
<td>1.000</td>
<td>90.0</td>
</tr>
</tbody>
</table>

3. Tracking Particles

In this chapter we let the computer do the actual tracking of the simulated particles. The complexity of the tracking scenarios is increased progressively in the examples below. Note that in these walk-through examples we will first set the program to just do the tracking and focus on the explanation of the settings after that. The analysis of the trajectories is outlined in chapter 4.

For reference, the picture below shows the main screen subdivided into the relevant control fields. The parts of the screen that will not be used in this tutorial are grayed out. The control fields to be adjusted are highlighted as follows:
3.1. Simplest case: One bright and slow particle in 2D.

In panel A, make sure that the mode is set to “Track particle”. Also in panel A, under the “Move” tab, Movement should be set to 2-Dxy. Now explore the “Cycles/particles” Tab. Max cycles can be left at 50,000 (after 50k tracking cycles the program stops tracking). DC threshold is used as a criterion to discern between particle and background signals (0.1 works fine for the settings used). Disregard the next three parameters for the time being.

In panel B, check “Simulation”, and make sure that the other two checkboxes are left unchecked. In C, the settings should be: Radius = 4, dwell time = 32us, R-periods = 4. Points per period = 64. With these settings the Period value should be 2048us and should appear in green. Make sure that “random” in the “Simulation” tab is selected.

Now you are able to start the simulation using the red button on the top of the window. Relax and watch how effortlessly the program tracks the particle in the three graphs shown on the screen. The mentioned graphs show projections of the inspected trajectory onto the $xy$, $xz$, and $yz$-planes, respectively. Since we’re limiting the simulation to two dimensions, the $xz$ and $yz$ graphs can be disregarded. The cyan circle represents the trajectory of the orbital scan and the trail shows the last 1000 points of the trajectory.

To stop the simulation press “OFF”. To save the full intensity versus time trace press “save huge file”. To save only the trajectory press “save trajectory file” under the File Tab.
The settings explained:

a) The Radius of the orbit was set to 4 pixels (or, in our case 0.2 µm), just slightly larger than the half-waist of the PSF (0.15 µm).

b) The Dwell time is the time between two successive points in the orbit.

c) The Period (time for one revolution) is calculated automatically taken into account the settings in “points per orbit” and the “Dwell time”. It should be appearing in green. If the calculated period appears in red, means that is not an allow number, which means that the period is faster than the scanner movement. The R-periods which is the total number of periods (R means in the radial, xy plane) is set to 4. That means the computer will record 4 orbits before computing the FFT and then will estimate the new position

d) The searching radius is, in pixels, the area around the initial coordinates that the program will explore to search a particle.

e) The sampling frequency is calculated automatically and is the inverse of the Dwell time.

Changing the radius is quite simple and straightforward. Try to use different scan-radii and save the trajectories for later analysis.

Changing the time settings has more aspects to it. The product between orbit time (the Period) and the sampling frequency determine the number of points per orbit, the size of the data-chunks fed into the FFT algorithm. For this reason, the product must be a power of 2 for the program to work properly. The product between orbit time and number of orbits gives the total time per estimated position. We will try out different time settings in later examples.

3.2. Next simplest case. One bright and slow particle in 3D

In panel A (Under the “Movement” tab) select “3D” and leave everything else as is (especially Axial-Distance = 4 and Axial periods = 1). After starting the tracking simulation two things may happen:

a) You’ll see the particle being tracked. In that case, relax and enjoy the show.

b) The particle is not being tracked and the scanner circles on the graphs are jumping back and forth. In that case, read on.

The routine is programmed to search for the particles automatically. It does so by increasing the size of the scanned orbit and by sweeping the center of the orbit in x, y and z. Eventually, the particle will be intersected by the orbit and then the routine will lock-in with it. This may take some time, however. The user can interfere at this point by selecting the particle on the graphs. In doing so the computer places the scanner centered at the user-pointed values and will find the particle more easily. Usually, the program has
more difficulties to find the right \(z\) coordinate. So pointing the particle on the lower graph should be the easiest way to get the orbit to lock-in with the particle.

The tracking is stopped by pressing the “OFF” button. Data is saved as outlined in the previous example.

The two new settings are axial-distance and axial-periods. Those determine respectively:

a) The distance between the top and bottom orbits, and b) the number of top-bottom cycles it should do before estimating the new \(z\) position. That means: The \(z\)-component in the scanner movement is updated at a different pace than the \(x\) and \(y\) components. One should keep this in mind when analyzing the data later on. To demonstrate this effect record one trajectory with axial-periods set to 1 and one with axial-periods set to 10.

### 3.3. One bright particle along a specified path.

In panel C, under the “Simulation” Tab, select “sinewave” instead of “random” and start the simulation as usual. The particle will now move in a three-dimensional figure-of-eight trajectory. This simulation mode is useful to characterize the tracking algorithm, since the particle moves in a known predefined way. The settings for this trajectory (Ampl-R, Ampl Z and Period) are in the control-boxes immediately below, and give the size and shape of the 3D trajectory. The tracking has to be stopped and started again for changes in the settings to take effect. Set the “sinewave” parameters from top to bottom, respectively: 64, 32 and 100. Track the particle once with the following settings:

a) \(R = 4\), dwell time = 32 \(\mu\)s, R-periods = 8, axial distance = 4, axial periods = 1, points per orbit = 64.
b) \( R = 4 \), dwell time = 32 \( \mu \)s, R-periods = 8, axial distance = 4, axial periods= 10, points per orbit = 64.

Note: The same problem as described above, namely, that the program might take a while to find the particle automatically, applies here. Pinpointing the particle in the \( x,z \) graph and clicking on it will resolve the problem.

3.4. Three particles in 3D.

Close the “simform” window. Then, using Options -> Particle parameters -> Particles, enter \( 3 \) in the “# mol” field of the form. Go back to the main tracking screen, and under the “Mode” Tab in panel A, select “Track many particles”. Now, go to the “Cycles/particles” tab and select 3 particles in the control box “# particles”. Note that the setting “cycles per particle” is set to 10. That means that the program will have the scanner centered at each particle for that number of “total cycles” (for instance, if we’re recording 1ms per orbit and using 8 orbits per positioning cycle, the scanner will be cycling through the particles and remaining with each one for 80 ms, yielding 10 positions in this time interval. In the next 160 ms the program will be recording particles 2 and 3).

Note: Don’t forget to go back to “random” motion in field C under “Simulation” tab. Now start the tracking.

3.5. What to do when things get more difficult...

In this part of the tutorial we will go through two situations that complicate things, and see what can be done as per the adjustments of the program to try to keep the problems at bay. The two things that will cause most problems in tracking are:

a) Limited brightness of particles
b) Too fast motion of particles

The natural thing to do to minimize the effect of a) is to increase the integration time, in which case the time resolution decreases. As a consequence, it will be more difficult to follow faster particles – worsening problem b). Conversely, to minimize b) one would try to acquire the orbits faster – in which case a) gets worse. In the following we will see in more detail how to set the relevant parameters. To avoid having to chase the particles in the \( z \) dimension, let us limit ourselves to 2D particle tracking for the next few examples. (To do that, select 2-Dxy in panel A, under “Move” tab)
The total scan-time is about 8ms and each orbit consists of 64 points. In order to increase the signal without changing the number of sampled points we can increase the number of orbits summed before the program estimates and jumps to the new position. On going from 4 to, say, 8 orbits we will have doubled the signal, but also doubled the time per trajectory point to 16ms. We can double the signal, however, without increasing time, by decreasing the sampling rate. To compare the both settings we can simulate an immobile particle, or a particle moving along a predefined trajectory and record a trajectory using i) the standard settings, ii) the increased time setting, and iii) the increased binning setting. We will see in the next chapter how to analyze trajectories, and be able to verify how the scan-time and binning properties affect the spatio-temporal resolution.

As an optional exercise, simulate increasingly faster and dimmer particles and find a good compromise between temporal and spatial resolution.
4. Analyzing Trajectories (Basics)

Obviously, once the trajectories are obtained, one would like to analyze them. SimFCS has a set of tools to do that. To access the trajectory analysis portion of SimFCS click on “Tools” -> “Analyze trajectory” from the tracking screen.

The trajectory analysis window opens. Different fields are highlighted for reference in the screenshot below:
Before examining each field and some of the basic capabilities of the analysis trajectory, let us load a set of exemplary data, so we have something to work with. Open a recorded trajectory file (in .txt format), for example the 3D random motion file, by selecting “Open trajectory…” from the “File” menu.

A number of graphs may be displayed (if not, make sure “Trajectories (xyz vs time)” is selected in field C and press the “Refresh” button on the right hand side of field D).

The graphs are influenced by using field A and field B. The labels are mostly self-explanatory. In the case of 1 tracked particle the highlighted fields in the zoom-in are of interest. Make sure they are all checked as shown in the figure.

If the tracking procedure worked fine, a series of red, blue and green lines should be displayed in the graph. It may look entirely, but not completely, unlike this:

Field A and B – Using the graph options

It is possible to zoom-in the graph by clicking on the top left of the area of interest on the graph and dragging the cursor to the bottom right. The graph will update to the zoomed in area as soon as the left button is released. (To zoom out, you reverse the mouse motion from the bottom right to top left – it will automatically zoom out completely). For example:
In the example above you see the particle and the scanner y coordinate in the time interval between 1498 and 1538 trajectory points (you have to remember the orbit time and the number of orbits to get real time). To find out which one of the traces represents the scanner and which one the particle un-check and re-check the scanner y co-ordinate in field B. The scanner position is adjusted after the particle position. You can change the appearance of the graph by double clicking on it and choosing different display settings.

Another note: The simulated particle position may not be displayed immediately on the graph, un-checking and re-checking the checkbox in “Sim particle 1” solves the problem.
4.1. Some details about trajectories

Load the simulated trajectory of the particle moving along the sinewave with 1 axial period, from example 3.3. a). The graph may look like this:

![Graph of particle trajectory](image)

Note that in the examples depicted here, the graphs have been cosmetically modified. Let us first zoom into the x-coordinate (red curve):

![Zoomed x-coordinate](image)

The red dotted curve corresponds to the scanner coordinate, the solid line to the particle coordinate and the black solid line represents the “real” simulated position (note that the
simulation is pixilated). In this graph one gets an impression about how well the positions are recovered from the actual trajectory.

Let us now zoom into the z coordinate and compare the two different settings. First, note the difference in the “noise”

![Graph comparing Axial-Periods = 1 and Axial-Periods = 10]
Let us zoom-in some more:

Note that the scanner position is updated only after 10 data points. In the meantime the program records the $z$ position as estimated from the tracking algorithm. They will appear to form ladders in the $z$-dimension.
4.2. Important Settings

So far all the displayed data was given in pixels. In field D it is possible to adjust the pixel-size so that the graphs now display the coordinates in physical space. The control boxes in field D are labeled intuitively.

4.3. Some Interesting Graphs

Besides displaying the coordinates of the trajectories it is also possible to obtain other types of graphs that aid in the interpretation of the observed motion. Some of them will be explained below.

**MSD:** This button gives you the Mean Square Displacement (MDS) value for the step length separated by 1, 2, 3, … time increments.

**Difference scanner-particle** (and the subsequent related ones): Gives, as the name aptly describes, the distance between the scanner center and the particle (simulated position, etc.). This graph can be used to test the positioning accuracy under different conditions.

**3-D trajectories:** Will display the trajectory in a special 3D graph window (screenshot depicted on next page). The controls in this window are mostly self-explanatory.

**3-D painted by trap p:** Uses a user defined criterion (in the control boxes in field D) to determine a trap probability threshold value. Steps that fall above and below the threshold are displayed in different colors.

**Histograms:** Produces histograms (averages and standard deviations) of all data currently displayed in the main graph. Each histogram opens in its own window and can be exported as a .txt file (by pressing the little “S” button in the graph).

**Distance vs. time:** Computes the distance of the particle to the origin as a function of time. This plot can be used to verify if there are periods in the trajectory characterized by faster or slower motion.
5. OK, Final Remarks

This tutorial certainly does not cover all aspects and details of particle tracking with SimFCS. Especially noteworthy is the omission of the “carpet” type analysis for the circular orbits. In case someone feels gutsy enough to play with that: It is accessible from “ScanningFCS” Tab in the main tracking screen.